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The Ohio Department of Education funds development of EMIS training materials
as part of the EMIS Alliance grant. There is an expectation that ITCs will utilize these
materials in training provided to your districts. That said, there are restrictions on
use of the EMIS Alliance materials as follows: Materials developed as part of the
EMIS Alliance program must be provided at no cost to your training participants. If
you utilize the EMIS Alliance training materials — in whole or in part — you must not
charge participants a fee to attend the class where the materials are used. Likewise,
you may not use the materials or any portion thereof in any event where a fee is
charged to attend. Exceptions must be approved in writing by the Department of
Education in advance of scheduling/promoting any event which may violate these
restrictions.

Questions regarding appropriate use of EMIS Alliance materials, or requests for
exception to the restrictions noted above, should be directed to Melissa Hennon
[Melissa.Hennon@education.ohio.gov].
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Overview

* The Federal Child Count (FCC)

* Includes students with disabilities who are receiving special education
services according to their IEPs as of October 31

* |s used in determining the amount of Special Education Part-B IDEA
and Early Childhood Special Education funds allocated to the state

» * |s collected from all LEAs except for ESCs and JVSDs through the
| Education Management Information System (EMIS) and is submitted
to the US Department of Education (USDOE)

* This presentation will focus on troubleshooting the EMIS FCC
Reports, which are generated throughout the EMIS data
submission process
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- EMIS Data Collections and the FCC Snapshot

* Collections containing the FCC report
* Beginning of Year Student (S) Collection
| * SOES Beginning of Year Student (S) Collection
6

. * Collections are scheduled to close December 21, 2020
| * FCC will close when the above collections close
* There is no appeal for the FCC



FCC Reports

* Level 2 Reports
* (FCCD-001) Federal Child Count Detail
e (FCCS-001) Federal Child Count Statement of Assurances

* FCC Reports are updated nightly
* Can contain data reported by other LEAs

* Review the most recent version of the reports throughout
the data collection process

* Submit updated EMIS data to make corrections to the
reports



Level 2 Reports

Beginning ion (FY21)
FY21-S-TRAD Init: Collection required for all Traditional Districts, JVSDs, ESCs, and State Supported Schools. Source file(s) for GI, FS, FD, FN, GE, ... %

Submissions: September 10, 2020 - December 21, 2020 (47 days till close)

Version: 3 @DE: Level 2 5>mg§
Status: The collection was submitted October 29, 2020 at 12:28:20 PM by

Submission Status: Processing Completed (October 29, 2020 at 12:28:15 PM)
Submission Number: 9 (attempt 2)

Actions: Start Collection Prepare Outputs: Level 1 Validations
Add New Scheduled Collection View submission 9 Data

Set Default Collection properties

Select the Level 2 Reports link
SOES Beginning of Year Student Collection (FY21)

FY21-S-SOES Init: Collection required for all Community Schools. Source file(s) for GI, FS, FD, FN, GE, FE,

, G), and GQ student record types, l...

Submissions: August 03, 2020 - December 21, 2020 (47 days till close)
Version: 2 @DE: u@
Status: The collection was submitted October 26, 2020 at 11:50:36 AM by
Submission Status: Processing Completed (October 26, 2020 at 11:50:23 AM)

Submission Number: 16 (attempt 1)

Actions: Start Collection Prepare Outputs: View missi
Add New Scheduled Collection
Set Default Collection properties

EMIS
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FCC Reports

Collection Requests = Collection Status @ Submissions @ Progress Reports = Archives

Messages Resources Preferences Data Sources @ Agenci

Data Feedback Reports and Files

Pre-Submission to ODE | Post-Submission and Processing by ODE
Level 1 Details | Highlights and Recent | Level 2 Details | Received Files Details

Level 2 Details

Choose the filter criteria then click the Show Reports link to generate the list of Level 2 reports matching these criteria. To see the option to Generate a single .zip file for all
reports (.csv), you must select a single Report Name, or select a single LEA and a single Collection Request or a single Category.

Filter Options
LEA: |Use IRN below v Collection Request:  FY21-S-TRAD Init v Data Set: All v School Year: All v Category: All v
LEA IRN: Report Name: All v Last Activity Within: All v Show closed collecti

Processed on or after: | (mm/dd/yyyy) Last Undated-orror—rirers
With Data Only: | Exclude reports with 0 rows Report Name includes: FCC

FCC was added to the
filter in this example

File Format: @ csy HTML

Group By: @ Collection Request LEA Level 2 Report Category Data Set None

htore Defaults | Reset Date textboxes

Status

Deselect All Categories

Last Upd Date Submission Help Page

Fatal Critical Warmm Info Total Category Process Date

Collection Request / Report Name

(Count: 2)

w Beginning of Year Student Collection (FY21) (2021S1TRD)

@ (FCcD-001) Federal Child Count Detail 6 2 25 89 122 Student Reports S 11/05/20 17:16 11/05/20 09:29 8 Unknown Help ...
©Q (£ccs-001) Federal Child 0 0 0 15 15 Student Reports S 11/05/20 17:16 11/05/20 09:29 8 Unknown Help ...
Generate a single.zip file for all reports | Export report information to a .csv file

Alliance




Formatting the FCC Detail Report

* Open the (FCCD-001) Federal Child Count Detail Report

* Wrap text header row

* Freeze top row

* Expand all columns

* Apply filters

* Better yet, run your macro!
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Quick Check

The Federal Child Count Detail
Report contains student detail
data as it pertains to the
count. This report is critical in
the data review and error
correction process and should
be carefully reviewed for
accuracy and completeness.

* Are you using the most recent
version of the report?

* Are you able to open and format
the CSV report to begin the review
process?

e Can you apply filters to all
columns?
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Troubleshooting
the Federal Child Count
Detail Report

Alliance



- Troubleshooting the FCC Detail Report

The next series of slides will review data contained in the
report including

e Severity Codes and Numbers

* Federal Child Count Flag

* Who is and is not included in my FCC?

* FCC Report Data

 Status Codes and corrective actions



Severity Numbers and Codes

Severity Numbers (ERR SEV NUM) are aligned with Severity Codes
* Report is sorted least severe to most severe
» Severity Code will be noted for each Status Code
e Review all students regardless of Severity Code

40404 10101 |
40404 10101 |

First Middle Name 15

W - Warnlng -39 irst N\ame Middle Name 15

A B C D - - G G Y

SEVERITY ERR SEV

1 |LEAIF ~ BldgIF ~ CODE ~ SSID v |[Emis ID |~ Last Nan ~  First Nan v | Middle Nan ~ NUM | ~

2 | 40404 10101 | JH7312067 123456789 Last Name First Name Middle Name > 15

3 | 40404 10101 | BR3857132 123456790 Last Name First Name Middle Nape T | 15

4 40404 10101 | | - Informational - 15 First N\ame Midefe Name 15

5

6

C —Critical - 63
F — Fatal - 79 T
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Federal Child Count Flag

FED CCT FLAG

Y — Student is intended to be included in the Federal Child Count
e N — Student not included in the Federal Child Count
* Review all students on the report regardless of flag

| | J K L M M 0 P Q

R
J ‘\‘ FED CCT FED CCT LEGAL DISAB STDNT  DISTLRE
g 1‘ STATUS FED CCT |LRE DIST OF CNDTN AGE SRC FED CCT
B ! CODE| = | FED CCT 5TATUS CODE DESCR | FLAG |~ JCODE |~ |RES I = |CODE * | MNUMBI ~ | CODE ~ | DIST LRE SRC DESCR * ALTIR ~
} FCODO8 Mo errors identified in ODE processing Y IE13 40404 5 10 8 GE Record
FCODO5 Student does not meet inclusion filter in this district N 50505 3 6 8 GE Record
FCO00S Student does not meet inclusion filter in this district N 50505 1 9 8 GE Record
FCO002 CIEP most recent IEP- should be no disability N 40404 5 5 8 GE Record
FC0002 Unable to translate LRE- must report FN270 element (N ) 40404 5 6 8 GE Record
i\
\ EMIS
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Who is included in my FCC?

* In most cases, students count at their resident district except for
students attending -
e Community Schools
* STEM Districts
| * Ohio School for the Blind
* Ohio School for the Deaf
* Buckeye United (DYS)
* Pilot Programs
* Non-Public students receiving related services count at the traditional

district providing the related services if active |IEP event is reported as of
October 31
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Who is not included in my FCC?

* Students with a disability as of October 31, who are not
being reported with an active IEP event as of October 31

 Students reported with the following IEP outcomes
* [EPR — IEP Complete — Parental Refusal
* [IENS — IEP Complete — Not Served
* [IEDP — IEP Resulted in Due Process

* Refer to the FCC Level 2 Report Explanation, section “Include
in USDOE Count” for additional information and exceptions



FCC Report Data

* Disability Condition Code

e Student must be reported to EMIS with a disability as of October
31 to be included on the report

* Review for accuracy

e Student Age Number
e Student’s age as of October 31

I J K L M ( N O \ P Q R

FED CCT FED CCT LEGAL |DISAB STDNT |DIST LRE

STATUS FED CCT LRE DIST OF|CNDTN AGE SRC FED CCT
CODE | ~ FED CCT STATUS CODE DESCR * FLAG ~ CODE ~ RESIF ~)CODE - NUMBI ~ JCODE ~ DIST LRESRCDESCR ~ ALTIR ~
FCO008 No errors identified in ODE processing Y IE13 40404 5 5 & GE Record

FCO008 No errors identified in ODE processing Y IE13 40404 5 7 8 GE Record

FCO008 No errors identified in ODE processing Y IE13 40404 15 8 & GE Record

FCO008 No errors identified in ODE processing Y IES5 40404 5 4 8 GE Record

FCO008 No errors identified in ODE processing Y IES1 4D4{]4k 16 ) & GE Record

EMIS
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- FCC Report Data, cont’d

|
|
;
i

* Legal District of Residence

|\« FED CCT ALT IRN
* Populated for Status Code FCO006 with LEA IRN where the student will count

 Sent Reasons and IRNs

* Displays if relevant to the FCC
~ p ~ —
L M N 0 p Q R s [ 1 U v w o\ X

FED CCT|LEGAL |[DISAB STDNT DIST LRE SENT SENT LEVEL 2

LRE DIST OF [CNDTN AGE SRC FED CCT |JADMSN |REASON SENTTO REASON SENTTO |RECTYPE

CODE| ~|RESIF ~ JCODE ~ NUMBI ~ CODE ~ DIST LRE SRC DESCR | ~JALT IR ~ |DATE ~J]1COD ~ 1LEAIF~ 2COD ~ 2 LEAIE ~|CODE |~

IE13 40404 5 5 8 GE Record 00:00.0 FCCD-001
: IE13 40404 5 7 8 GE Record 00:00.0 FCCD-001
‘ IE13 40404 15 8 8 GE Record 00:00.0 FCCD-001
R IESS 40404 5 4 8 GE Record 00:00.0{ES 20202 FCCD-001
' \ IE51 L 404053 16 3 8 GE Record L ) 00:00.0 \E{ 20202 / FCCD-001

\ EMIS
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- FCC Report Data, cont’d

 FED CCT LRE Code — Least Restrictive Environment Code
* If this is blank, the student is not included in the count
e Value comes from IEP, FN270, or is derived

* DIST LRE SRC CODE and DIST LRE SRC DESCR

* Source codes indicate what data the report is looking at

reported for each student

* Use in combination with the Status Code value to determine what is being

I J K € L [\ M Q P Q \
FED CCT FED CCT LEGAL DISAB STDNT DIST LRE
STATUS FED CCT | LRE IST OF CNDTMN AGE SRC
CODE ~ |FED CCT STATUS CODE DESCR * |FLAG |~ |CODE | ~ |[RES IF ~ | CODE ~ | NUMBI ~|| CODE | ~ | DIST LRE SRC DESCR =
FCOO08 MNo errors identified in ODE processing Y IE13 40304 5 g 8 GE Record
FCO008 Mo errors identified in ODE processing Y IE39 40404 12 q A Sent Reason =AU or IP
FCO005 Student does not meet inclusion filterint N 50505 3 14 5 No IEP Reported
FCO001 On Oct 31 students age is outside 3-21 incl N 40404 16 3 3 Student Age not 3-21
FCO002 Mo errors identified in ODE processing Y IE13 40404 10 10 7 FN270 Override
FCO008 Mo errors identified in ODE processing Y \E13 ) 40404 15 ?& 8 GE Record j

EMIS
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- LRE Source Codes, cont’'d

~ *1-No Disability on October 31 *New*
e 3 - Student’s ageisnot 3 —-21
*5-No IEP Reported

| *7-FN270 Override

e 8 - GE Record
I | J K L M N 0 P Q \

FED CCT FED CCT LEGAL DISAB STDMNT |DISTLRE
} STATUS FED CCT LRE DIST OF CNDTN AGE SRC
CODE | = |FED CCT STATUS CODE DESCR ~ |FLAG = |CODE -~ |RESIF = |CODE = | NUMBI ~| CODE |-T| DIST LRE SRC DESCR o
FCO008 Mo errors identified in ODE processing Y IE13 40404 5 7 FN270 Override
FC0002 Unable to translate LRE- must report FN270 element N 40404 1 5 8 GE Record
FCO004 Mo IEP reported for Oct 31 date N 40404 13 1 5 Mo IEP Reported
FCO001 ©On Oct 31 students age is outside 3-21 included range N 40404 12 3 Student Age not 3-21
N 40404 12 3 5 No IEP Reported /

FCO004 No IEP reported for Oct 31 date
EMIS

\ VS 19
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LRE Source Codes, cont’d

* 9 - How Received =6
 FED CCT LRE CODE will be IE39 Ages 5 and up, Not Grade Level PS
 FED CCT LRE CODE will be IE39 Ages 6 and up, Grade Level PS

* C- How Received = 6 and Grade Level =PS *New*
 FED CCT LRE CODE will be IE51 if Ages 3 to 5 and Grade Level PS

* A-Sent Reason =AU or JP
 FED CCT LRE CODE will be IE39 if age 6 or older and IE51 if age 3-5

| * B-Changed to DYS LRE (Appears only on DYS report) *New*

AR [ J L M N o] (P Q \

,3’ ‘ FED CCT FED CCT LEGAL DISAB STDNT |[DISTLRE

| STATUS FED CCT LRE DIST OF CNDTN AGE SRC

' CODE ~ | FED CCT STATUS CODE DESCR * FLAG |~ |CODE ~ |RESIF * | CODE ~ NUMBI * JCODE -T DIST LRE SRC DESCR ol
FCO008 No errorsidentified in ODE processing ¥ IES1 40404 12 4 1A Sent Reason =AU or JP

( | FCOO08 No errors identified in ODE processing

Y IE39 40404 5 6 9 How Received =6
FCO0O08 MNo errors identified in ODE processing ¥ IE39 40404 1 10jA Sent Reason =AU or JP
FCO008 No errors identified in ODE processing Y IES1 40404 5 5 How Received =6 and Grade Lev
\ FC0008 No errors identified in ODE processing ¥ IES1 40404 5 5 ix How Received =6 and Grade ij
EMIS

o & 3 20
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Quick Check

The Federal Child Count Detail
Report contains data specific
to students with disabilities.
Understanding each column
of data is important to begin
analyzing the data for
accuracy and completeness.
There is not an error for
everything, so time spent
reviewing all data on the
report is recommended.

* Are all students appearing on the
report as expected?

e Has someone verified the data for
accuracy?

* Has updated EMIS data been
submitted to correct any
inaccuracies on the report?

EMIS
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" FED CCT Status Codes

z
|
|
;
%

FED CCT STATUS CODE and FED CCT STATUS CODE DESCR
* Indicates the status of a student as it relates to inclusion in the count
* Indicates that a data issue exists or that no errors are identified
e Data with no errors on the report should still be reviewed for accuracy

E_F_G»H(I J \KLMN

FED CCT FEDCCT LEGAL DISAB

STATUS FED CCT LRE DIST OF CNDTN
Emis ID | ¥  Last Nan v | First Nan v |Middle Nam | CODE v  FED CCT STATUS CODE DESCR v |[FLAG ~ CODE |~ RESIF v CODE ~
123458627 Last Name First Name Middle Name| FCO008 No errors identified in ODE processing Y IE13 40404 5
123458662 Last Name First Name Middle Name| FC0005 Student does not meet inclusion filter in this district|N 50505 5
123458669 Last Name First Name Middle Name| FC0002 Unable to translate LRE- must report FN270 element [N 40404 1

123458670 Last Name First Name Middle Name {2)004 No IEP reported for Oct 31 date
0001

N 40404 13
\ 123458671 Last Name First Name Middle Name On Oct 31 students age is outside 3-21 included ra)& N 40404 12
EMIS
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FED CCT Status Code FC0001

Filter on FC0001

* On Oct 31 Student age is outside the 3-21 included range (Fatal)
e Source Code 3 - Student age is not 3—-21
* FED CCT FLAG - N

* View the student’s reported date of birth on the Student
Demographic (Gl) Record to confirm age

* |f the student’s date of birth is incorrect, make the correction and
submit updated EMIS data

EMIS
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FED CCT Status Code FC0002

Filter on FCO002

* Unable to translate LRE-must report FN270 element (Critical)
e Source Code 7 - FN270 Override
* or Source Code 8 - GE Record
* FED CCT Flag - N
* As of October 31 the student’s IEP Outcome (LRE) must agree with
the student’s age and grade level

e For ages 3-5 and in preschool, the LRE should be in the IE51 to IE72
range, if not report an LRE within this range on the FN270

* For ages 5 and over and in kindergarten or higher, LRE should be in
the2IE013 to IE39 range, if not report an LRE within this range on the
FN27

EMIS
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Age, Grade Level, and Expected LRE

* Age 3to 5, Preschool Grade Level - Count as Preschool Student
* Preschool LRE Expected (IE51-1E72)

* Age 4, Kindergarten Grade Level - Count as Preschool Student
* Preschool LRE Expected (IE51-1E72)

* Age 5 and up, Kindergarten Grade Level - Count as School Aged
Student
* School Aged LRE Expected (IE13-IE39)

* Age 6 and up, Any Grade Level, including Preschool - Count as
School Aged Student

* School Aged LRE Expected (IE13-IE39)




Reporting the FN270 Element

Updated October 31 IEP Outcome Element (FN270)

e The current IEP outcome and FN270 values should not be the same

* When the FN270 value is reported correctly the LRE that aligns with

the student’s age and grade level will appear in the column FED CCT
LRE CODE

* When reported incorrectly the FED CCT LRE CODE column will be
blank

I . K L M N (o) P Q R
FED CCT CO rrect FED CCT LEGAL DISAB STDNT DISTLRE
STATUS FED CCT LRE DIST OF CNDTN AGE SRC FED CCT
CODE ~ FED CCT STATUS CODE DESCR \'&Q CODE v RESIF v CODE ¥ NUMBI-Y CODE | ~ | DIST LRE SRC DESCR v ALTIR v
FCO008 No errors identified in ODE processing Y IES1 40404 16 5 8 GE Record
FCO008 No errors identified in ODE processing Y IE1S 40404 12 5 7 FN270 Override
FC0002 Unable to translate LRE- must report FNN 40404 5 5 8 GE Record
FC0002 Unable to translate LRE- must report FNN 40404 6 5 7 FN270 Override

Incorrect EMIS

. 26
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FED CCT Status Code FC0003

Filter on FCO003

* CIEP most recent IEP - should be no disability (Warning)
e Source Code 8 - GE Record
* FED CCT FLAG-N

* Verify the CIEP event and confirm that the student’s disability code
is being reported as ending on the date of the CIEP event

* If the student’s disability code on the Student Attributes - Effective
Date (FD) Record is not reported as ended, make the correction
and submit updated EMIS data

EMIS
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FED CCT Status Code FC0O004

Filter on FC0004

* No IEP reported for Oct 31 date (Fatal)

| * Source Code 5 - No IEP Reported

| * FED CCT Flag — N *NEW*

»  FED CCT LRE CODE — Blank *NEW*

| * Verify the student’s special education event records as of October 31
* Verify the most recent IEP was reported to EMIS

e Report an NIEP if appropriate

EMIS
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- ODDEX Records

Special Education Data Tab
e Use to verify if the student’s IEP events were reported to EMIS

Ohio | ™®* ™= Ohio District Data Exchange (ODDEX)

Home SOES SCR Records CCP Tuition Calendar Users Agencies -

History Special Education

= Return to Summary

Name

Event Date Event Type
0472372019 RIEP
042772018 RIEP

Qrf24r017 AlEF

Assessments

SSID
Outcome Outcome Dates Non-Compliance
IE14 0472372019 - 0472272020 MIA,
IESS 0472712018 - 047262019 MiA
IEST 072472017 - 04262018 NIA

Secondary Planning
MIA
MIA

MIA

Birthdate

Required Test Type
5TA
STA

SR

Records Single Student

ODDEX Help About Log Out

Help
-

Reported by LEA

EMIS
W o""‘ - 29
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" NIEP Date Type - No IEP

* NIEP events using the non-compliance reasons 10 or 11
should be reported no longer than 30 days

* 10 - Student newly transferred in; IEP adoption determination not
complete; services being provided based on prior [EP

» * 11 - IEP expired; new IEP not in place; services being provided
\ based on prior IEP

* NIEP events using the non-compliance reason of 12 can be
used until the end of the IEP that did not get reported to
EMIS



FED CCT Status Code FCO005

Filter on FCO0O05

e Student does not meet inclusion filter in this district (Warning)
* Source Code 5 - No IEP Reported
* or Source Code 7 - FN270 Override
e or Source Code 8 - GE Record
 FED CCT Flag—N

* Shared students can have this Status Code at the educating district

e Shared students where IEPs are not reported can also have this
Status Code with Source Code 5 — No |IEP Reported

» Refer to the Federal Child Count Report Explanation, section “Include
in USDOE Count”

EMIS
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FED CCT Status Code FC0Q00S5, cont’d

Filter on FCO0O05

» Student does not meet inclusion filter in this district (Warning)

e Source Code 9 — How Received =6
 FED CCT Flag—N

* Non-Public special education students receiving related services
from reporting district with No |IEP reported on October 31

* Report does not consider ISPs
* If no IEP in place on October 31, then the student is not included in the FCC

EMIS
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Multiple District Tie Breakers

1. Will count at Buckeye United if reported by Buckeye United (060988)

2. Will count where Reporting IRN = District of Residence IRN
~OR~ counts where Reporting IRN is reporting a How Received code of

M (Community School) or K (STEM District)

3. If multiple entities are claiming the student in the same way (as #2
above), then the student is included at the entity with the later

admission date

4. If entities are claiming the student in the same way (as #2 above) and
reporting the student with the same admission date, then the student

will not count for any district

EMIS
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FED CCT Status Code FCO006

Filter on FCO006

* Student counting in alternative district - does not count in your
district (Warning)

* Source Code 5 - No IEP Reported - verify if special education events need to
be reported for this student

or Source Code 7 - FN270 Override

or Source Code 8 - GE Record

or Source Code 9 - How Received =6

or Source Code A - Sent Reason AU or JP
FED CCT Flag - N

e Student counts at the IRN in the FED CCT ALT IRN column
* Review data in ODDEX to compare how data is being reported

e Communicate with the alternative district to determine how this
student should be reported

EMIS
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- FED CCT Status Code FCO007

Filter on FCO007

 Student excluded -conflict in where student should count (Fatal)
e Source Code —7 FN270 Override
e Or Source Code — 8 GE Record
 FED CCT Flag - N

e Could not determine where this student should count, so the student
will not be counted at either entity

* Review data in ODDEX to compare how data is being reported by both
entities

* Communicate with the other entity to determine how this student
should be reported

EMIS
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FED CCT Status Code FCO008

Filter on FCO008

* No errors identified in ODE processing (Informational)
* Source Code 7 —FN270 Override
e or Source Code 8 — GE Record
e or Source Code 9 — How Received =6
* or Source Code A —Sent Reason = AU or JP
e or Source Code B — Changed to DYS LRE (appears on Buckeye United FCC Report)
* or Source Code C— How Received = 6 and Grade = PS
 FED CCT Flag—-Y

e Data for the students should be reviewed for accuracy
* Apply filters to verify elements such as disability conditions and LREs

* District staff can be very helpful in verifying data accuracy and
completeness

EMIS
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e Have all status codes been

Quick Check reviewed, and all reporting issues
The Federal Child Count Detail corrected?

report will display students * When corrections have been

who are and who are not : : :
included in your count. The made in the student information
report will also indicate system (SIS), has that updated
students with issues data been submitted to EMIS?
preventing them from being

included. Check this report e Based on inclusion criteria are all
often as it can be effected by of your special education students

another entity’s EMIS :
reporting. being counted correctly?

EMIS
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Troubleshooting
L the Federal Child Count Statement of
Assurances Report
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|
\
|
3
|

A B c
DISAB Format the report
CNDTN STUDENT by wrapping the
1 CODE ~ |DISABILITY DESCR * | COUNT - .
2 [=___Is,4,and 5 vear Olds with a disability (Any) 7| |textin the header
3 1 Multiple Disabilities (other than Deaf-Blind) 21 row and expanding
4 2 Deaf-Blindness 0 Il |
- 3 Deafness (Hearing Impairment) 12 all columns
6 4 Visual Impairments 6
7 > speech and Language Impairments 63
g & Orthopedic Impairments 3
9 8 Emotional Disturbance (SBH) 16
10 9 Intellectual Disabilities (Formerly Mental Retardation or -see Manua 21
11 10 Specific Learning Disabilities 120
12 12 Autism 47
13 13 Traumatic Brain Injury (TBI) 8
14 14 Other Health Impaired (Major) 0
15 15 Other Health Impaired (Minor) 27
16 16 Developmental Delay 1 EMIS

""o"‘~ 1 39

Alliance



Understanding Statement of Assurances

* The report includes
* only students who have a FED CCT Flag =Y
* all students age 3 to 5 in the first category
 students age 6 to 21 in each disability specific category

* Using the above criteria the next series of slides will match
the FCC Detail Report against the FCC Statement of
Assurances Report

* When you are told that the counts on this report are
incorrect, filtering allows you to show which students are
included or not included



Filter on FCC CCT Flag

D E F G H I ] L

FED CCT FED C
STATUS LRE

551D - |[Emis ID | = | Last Nan = | First Nan = Middle Nan| = | CODE| ~ | FED CCT STATUS CODE DESCR CODE
VR2595285 123458300 Last Mame First Name Middle Name FCO008 Mo errors identified in ODE processing El SortAtoZ IE39
PRA141869 123458302 - : prs identified in ODE processin —_ IE14
TD2775738 123458305 brs identified in ODE pro . - IE14
V3483978 123458306 SEIECt Y on the hrs identifiedd processin;  ~ortby Color IE15
BV7684592 123458308 FED CCT Flag Filter on entified in ODE processinj IE13
Dx5057594 123458314 brs ntified in ODE processin IE13
HR2157668 123458317 the Fcc Deta" Re port brs idenied in ODE processin IE13
NV4577195 1234583138 rs identifie ODE processin IE13
FZ6057966 123458322 Last Mame First Name Middle Name FCO008 Mo errors identified in O rocessing Text Filters IE1S
VWB769849 123458323 Last Mame First Name Middle Name FCO008 No errors identified in ODE pridgssin) - IE13
RZ3069017 123458329 Last Name First Name Middle Name FCO008 No errors identified in ODE proces search IES1
BV8310095 123458335 lactilama Eiccthoma Middlg Mama EC0002 Mo gorors identified in ODE processing E Select All) IE13
MRE579707 123458336 brs identified in ODE processing IE13
LD2735940 123458339 These are the students brs identified in ODE processiny -HY IE35
LB4451023 123458341 H H brs identified in ODE processing IES1
DP6228655 123458346 Who are |nCI UdEd In brs identified in ODE processing IE39
( PF9210057 123458353 the Statement Of brs identified in ODE processing IE14
d TZ5740899 123458369 brs identified in ODE processing IE39
] | L79288577 123458371 Assu rances Re port brs identified in ODE processing IE13
MB5852167 123458403 rs identified in ODE processing IE13

\ JD4837822 123458420 Last Name First Name Middle Name FC0O008 No errors identified in ODE processin Cancel | [IESL | o

\ Alliance



|
1

i
{
{
1

!
|
l

- Add Second Filter on Student Age Number

G H | J K M N (@)
: FED CCT ' FEDCCT LEGAL DISAB STDNT
‘ [ STATUS FED CCT LRE DIST OF CNDTN AGE
| /] First Nan ¥ /Middle Nan| v |CODE| v | FED CCT STATUS CODE DESCR v |FLAG |-T|CODE ~ |RES IF ¥  CODE ¥ | NUMBI-T|
First Name Middle Name FC0008 No errorsidentified in ODE processing 1 il Sort Smallest to Largest
First Name Middle Name FC0008 No errorsi 1
First Name Middle Name FCO008 No errorsi SEIECt ages 3, 4 and ] Al SortLargestto Smallest

First Name Middle Name FC0008 Noerrorsi Sort by Color >

First Name Middle Name FC0008 No errors iI 5 on the StUdent Age ]
First Name Middle Name FC0008 No errorsi Number Filter ]

First Name Middle Name FC0008 No errorsi
First Name Middle Name FC0008 No errors identified in ODE processing

v Clear Filter From "STDNT AGE NUMBER'

First Name Middle Name FC0008 No errors identified in ODE processing Number Filters >
First Name Middle Name FC0008 No errors identified in ODE processing ——
First Name Middle Name FC0008 No errors identified in ODE processing "'”‘:" A
| First Name Middle Name FC0008 No errors identified in ODE processing ] (Select All 2
, First Name Mi . .
| |astname wid These students are included in the 3, 94
! V5
| First Name Mi . . TH | [ e
{ - L 16
e il 4, and, 5-year olds with any disability { | o
First Name Mi ' (
f '10on the Statement of Assurances report , Qe
] First Name Mi g
s \_‘ First Name Middle Name FC0008 No errors identified in ODE processing 1 (]10 o
\ First Name Middle Name FC0008 No errors identified in ODE processing ]
First Name Middle Name FC0008 No errors identified in ODE processing ) Cancel
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Matchmg Data Between Reports

J M P O
FED CCT LEGAL DISAB STDNT DIST LRE
FED CCT LRE DIST OF CNDTN AGE SRC

R ~ FLAG |-T| CODE| ~ |RES If ~ | CODE ¥ | NUMBI-T| CODE | ~ | DIST LRE SRC DESCR
processing Y 40404 5 5 8 GE Record
processing Y 40404 16 3 8 GE Record
processing Y 40404 16 5 8 GE Record
processing Y 40404 16 3 8 GE Record
processing Y 40404 6 3 7 FMN270 Override

| processing L 40404 16 4 8 GE Record
processing Y 40404 16 3 8 GE Record

\ processing Y 40404 16 3 8 GE Record

' processing Y 40404 5 4 7 FM270 Override
processing Y 40404 5 4 7 FN270 Override
processing Y 40404 3 5 8 GE Record
processing Y 40404 16 4 8 GE Record
processing L 40404 16 4 8 GE Record
processing Y 0404 16 4 8 GE Record
processmg Y AN04 5 5 7 FN270 Overrlde

2. This will match the count on the Statement of Assurances.

1. From the filtered students on the FCC Detail Report, select

a range of cells and see the “count” appear at the bottom

of the spreadsheet

g T ProTeEssTT
XM 18 processmg
i |‘ ',‘ h processtng
processing
l; | processing

processing
[ processing
processing
processing
processing
processing

<[ || [ [ |||

T T
IE51
IE51
IE72
IE15
IES1
IE13
IES1
IE51
IE51

IES1
=

=TT
40404
40404
40404
40404
50505
40404
40404
40404
40404
40404

(LR

4 A
5C
5C
5 A

T TTETOTD
8 GE Record

8 GE Record

7 FN270 Override

7 FN270 Override

GE Record

Record

SeN Reason =AU or JP
How Ngceived = 6 and Grade Ley
How Redgived =6 and Grade Ley
Sent Reasdg\=AU orJP

A C

DISAB

CNDTN STUDENT
1 |CODE ~ | DISABILITY DESCR ¥ |COUNT ~
2 I !3, 4, and 5 Year Olds With a disability (Any) 47
3 1 Multiple Disabilities (other than Deaf-Blind) 21
4 2 Deaf-Blindness 0
5 3 Deafness (Hearing Impairment) 12
6 4 Visual Impairments ]
7 5 Speech and Language Impairments 63
8 6 Orthopedic Impairments 5
g 8 Emotional Disturbance (SBH) 16
10 9 Intellectual Disabilities (Formerly Mental Retardation or -see Manua 21
11 10 Specific Learning Disabilities 120
12 12 Autism 47
13 13 Traumatic Brain Injury (TBI) 8
14 14 Other Health Impaired (Major) 0
15 15 Other Health Impaired (Minor) 57
16 16 Developmental Delay 1

EMIS
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-~ Arrange All

With two spreadsheets
open at the same time,
from the View tab select
“Arrange All” and then
“Vertical” and “OK”

File Home Insert Page Layout Formulas Data Review

l H m [ﬁ < Formula Bar CJ\ [ﬂ

Mormal Page Break Pasge Custom ) Gridlines [~ Headings Zoom 100% Zoomito
Preview  Layout Views Selection Wi

Shigel View Werkbook Views Shebw 00

A2 i F

& B C D E F
DISAB
CNDTM STUDENT
CODE = | DISABILITY DESCR | OOUNT -

I-- |i, 4, and 5 Year Olds With a disability [Any) a7

1 Multiple Disabilities (other than Deaf-Blind) il --ﬂnangt'ﬂi;dnm

2 Deaf-Blindness 1]

3 Deafness (Hearing Impalrment) 1 Amrange

4 Visual Impairments [ () Tiled

5 Speech and Language Impairments 63 Q Hurzont

& Orthopedic Impalrments 5 @) Yertical

8 Emotional Disturbance [SEH) 16 (O Caseade

9 Intellectual Disabilities (Formerly Mental Retardation or -see Manua 21 [ windews of active workbook
10 Specific Learning Disabilities 120
12 Autism a7 Fancel
13 Traumatic Brain Injury (TBI] B
14 Other Health Impaired (Major) 0
15 Other Health Impaired |Minar) 57
16 Developmaental Delay 1
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~ Arrange All cont’d

AutoSave (B 020

(FCCS-001) Federal Child Cownt.. =

both spreadsheets to

File Home Iresdert Fage Layout Formulas Data Rty ‘.:'_rrw Hilp =] File Home Insert Page Layout Formulas E Renew Wiew Help i =]
~ * A {4 »

o Bl = Q[gH 9 FH @on 2% & v | “Arrange All” allows
abeet | Waoikbook | Shew Ioom 100% Foomio | Wedew | Macmos (et Refresh [ista it &
Wiew = | Views - = Selection = - Diata ~ EH &l = Types~ | Filter =

Zoom Blscros Geefd & Trarcform Dats | Cuerdes & Connections | Dats Types
[ ]
2 - AE Q- . | v be viewable at the
-1 [ ]
s : . o5 2% Isame time
CHDTH STUDENT SEVERITY

1 CODE = | DISABILITY DESCR = | COUNT ~ 1 LEAIF~ |BIdgIF ~ |CODE |- 55D = |Emis 1D~ | Last Nan = | First Nan = | Middle Na
2 | !3. 4, and 5 Year Olds With a disability [Any) 47 256 aba0d 10001 | MH3L3E939 123457237 Last Mamae First Name Middle Ma
3 1 Multiple Disabilities (other than Deaf-Blind) 21 266 ADAD4 10101 | AFE1509884 123457314 Last Mame First Name Middle ba
4 2 Deaf-Blindnieis ] 26T Aland 10001 | BP2998263 123457317 Last Name First Name Middle Na
5 3 Deafness (Hearing Impairment) 12 68| S0dA0d 10101 | JDE52B501 123457318 Last Mame First Mame Middle Ng
[ 4 Visual Impairments & 260 aluala 10001 | PMNIB11961 123457321 Last Mame First Mame Middle N3
7 5 Speech and Language Impairments 63 2700 Apa0a 10001 | RMTIO9E35 113457322 Last Name First Name Middle Na
8 & Orthopedic Impalirments 5 271 afstd 10001 | JETAAS311 123457304 Last Mame First Name Middle Na
g 8 Emotional Disturbance [SBH) 16 272 ADADA 10101 | VAZ541404 123457325 Last Mame First Name Middle ba
10 9 Intellectual Disabilities [Formerly Mental Retardation or -see Manua 1 273 ADAnd 10001 | MNVS0O1268 123457305 Last Name First Name Middle Ma
1 10 Specific Learning Disabilities 120 274 A0A0d 10101 | TS 123457330 Last Name First Mame Micdle MNa
12 12 Autism a7 275 el 10001 | LF1463079 123457333 Last Mame First Mame Middle N3
13 13 Traumatic Brain Injury [TEI) B 276 Apa0E 10001 | XILS00126 123457336 Last Name First Name Middle Na
14 14 Other Health Imipaired {Major) o 2TT apa0a 10001 HDE2E8188 123457337 Last Name First Name Middle Na
15 15 Other Health Impaired |Minor] 87 T8 a0a0d 10001 | JHT249587 123457338 Last Mame First Mame Middle Na
16 16 Developmental Delay i 2TH|  Aland 10001 | HM3IE5645 1X3A5TEA0 Latt Namé First Name Middle Na
17 280|  A0and 107201 | MHEZX19356 123457341 Last Name First Name Middle kd
18 AT a0 10001 | WHI1ELA3TE 1Z3457342 Last Mame First Mame Middle N3
19 Qa2 ik 10000 | JNT616668 123457343 Last Mame First Mame Middle N3
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:" Change the Student Age Filter

F G H I ] kK L [ ! O P
FED CCT LEGAL DISAB STDNT DIST LRE_
STATUS FED CCT FED CCT  DIST OF CMNDTM AGE SRC

Last Mam ~ First Man ~ | Middle Man ~ | CODE| ~ | FED CCT STATUS CODE DESCR - |FLAG |-T|LRECOLC ~ |RES IRN| ~ [CODE |~ |NUMBE} ~ | CCODE |~ | [

Last Mame First Name Middle Name FCO008 Mo errorsidentified in ODE processing gl Sort Smallest to Largest 8 d

Last Name First Name Middle Name FCO008 Mo errors identified in ODE proceset Y 7 8 g

A\I/ Sort Largest to Smallest

Last ¥ 8 g

stN Leave the FED CCT Flag Y Sort by Coler ’ 3 @

! Last . Y EE

Last C0|umn f||ter set to identified in ODE processing Y 7 F

Last E identified in ODE processing Y 8 g

Last ShOW Only Y \Ialues L identified in ODE processing | Y g8 d

Last e T——rErTTE— k identified in ODE processing | Y Mumber Filters % 8 d

Last Mame First Name Middle Name FCO008 Mo errorsidentified in ODE processing Y 8 g

! Last Mame First Name Middle Mame FCO008 Mo errors identified in ODE processing Y seareh P 7 H

j Last R ¥ —[m] {Select All) - 3 G

| || Change the filter for the Student v = 3 d

Last . 8 g

=:| Age Number column to include v B T

Last ¥ 7 H

o] all ages except 3,4, and 5 v o oF

Last Name First Name Middle Name FCOD0E8 MNo errors identitied in ODE processing | Y L 8 g

Last Mame First Name Middle Name FCO008 Mo errorsidentified in ODE processing Y [ 10 o 8 g

Last Mame First Name Middle Name FCO008 Mo errors identified in ODE processing Y o 8 g

“‘ Last Mame First Name Middle Name FCO008 Mo errors identified in ODE processing Y Cancel 7 F
\ '" ' T EMIS
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Add a Third Filter

G H I J
' FEDCCT
STATUS
First Nan ~

First Name
First Name
First Name
First Name
First Name
First Name
First Name
First Name
First Name
First Name
First Name
First Name

First Name
First Name
First Name
First Name
First Name

Add a third filter in
the DISAB CNDTN
CODE column

DE processing

Middle Name
Middle Name
Middle Name
Middle Name
Middle Name

Select one disability
code at a time

e Name
Middle Name
Middle Name
Middle Name
Middle Name

FCO008
FC0008
FC0008
FC0008
FC0008

No errors identified in ODE processing
No errors identified in ODE processing
No errors identified in ODE processing
No errors identified in ODE processing ,
No errors identified in ODE processing 5

ODE processing

FCO008
FC0008
FC0008
FC0008

No errors identified in ODE processing
No errors identified in ODE processing
No errors identified in ODE processing
No errors identified in ODE processing
No errors identified in ODE processing

K | L M

LEGAL

FEDCCT FEDCCT DIST OF

FLAG -T/LRECOC ~ |RESIRN v | CODE

él Sort Smallest to Largest

ort by Color

N
DISAB
CNDTN

N2 Clear Filter From "DISAB CNDTN CODE"

Number Filters

search

¥ [ (Select All)

v
(13
[ 14
(15
L16
18
19
110

>

Cancel

| O
STDNT
AGE

10

O 00 v W w

15
15
17
16
18

15

14
17

17
17

11

p

'DIST LRE

SRC

¥ NUMBEI ~ CODE | ~

SN0 N 0000 S s 0000 00 00 00 0 0O 00 00 00 00 00 0 0
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- Match the Data Between the Reports

K L M M (s} Q R 5
A 8 C LEGAL DISAB STDNT DI5ST LRE b
FED CCT FED CCT DIST OF CNDTM AGE SRC FED CCT ADMSMN F
D|SAB FLAG -T|LRECOC ~ RESIRN ~ |CODE |-T NUMBEI-T| CODE |~ |DIST LRE SRC DESCR * ALTIR =~ |DATE - 1]
Y IE15 40404 1 10 8 GE Record 00:00.0
| (CNOTN STUDENT | I | wis 1 8 8EReco o000
1 /CODE ~ DISABILITY DESCR VICOUNTLY | s ) I T T o000
2 [ 3,4,and5 Year Olds With a disability (Any) al| e e oma| 330 slcEnes oue00
3 1 Multiple Disabilities (other than Deaf-Blind) 21 e a0 2 e 8|08 hecord ot
4| 2Deaf-Blindness 0 I fes s0m] i 3| slareecom 0000
5 3 Deafness (Hearing Impairment) 12 . o : “ 8/S€ fecord 00000
6| 4 Visalimpaiments o o e L Zremowns come:
7 5 Speech and Language Impairments 63 g IE16 40404 ! 17 O/GERecord _ 00:00.0/F
8 6 Orthopedic Impairments 5 i .
9 8 Emotional Disturbance (SBH) 6| ¥ 1. From the filtered students on the
¥ [ ]
2'“ h.“' n ‘" h h T . FCC Detail Report, select a range
. This will match the count on 120 “ ”
e s ‘ = of cells and see the “count” appear
the Statement of Assurances.
: at the bottom of the spreadsheet.
14 14 Other Health Impaired (Major) 0
15 15 Other Health Impaired (Minor) 57 \
16 16 Developmental Delay 1

‘ Count: 21 >

. 1N
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Quick Check

The Federal Child Count
Statement of Assurances
Report is derived from the
same data that is on the FCC
Detail Report. Using filters,
you can match the data
between the reports. The
Statement of Assurances is
sometimes requested by
auditors.

* Can you match the data between
the two reports using filters?

* Are you seeing the numbers of
students that you were expecting?

* Has this data been shared with
others in your district?

EMIS

Alliance



Summary

* The FCC Reports contain both data to verify and issues to
correct

* Some issues can be corrected, and some are simply stating
the fact that the student cannot be included in the count

* Work with district staff to verify that the data is both correct
and complete

* “No errors” does not necessarily mean that your data is
accurate



Resources

* Federal Child Count Detail Report and Federal Child Count
Statement of Assurances Report Explanation

e ODE Home > Data > EMIS > Documentation > EMIS Validation and
Report Explanations

e EMIS Manual
e ODE Home > Data > EMIS > Documentation > EMIS Manual

e Your district staff
* Your ITC



Questions?

Please complete a feedback form to receive your attendance certificate
https://tinyurl.com/EA-District-Feedback

EMIS
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https://tinyurl.com/EA-District-Feedback

